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Sl. No. Topic No. Of MCQ 

1 Shortcut Key & Full Form 288 

2 Internet and its Services 294 

3 MS Excel 291 

4 MS Word 379 

5 MS PowerPoint 137 

6 Computer Hardware & Software 226 

7 Computer Memory 187 

8 Miscellaneous 407 

9 Data Communication and Networking 93 

10 Operating System 99 

11 Programming Concepts 49 

12 Windows 33 

13 Database Concepts 24 

14 Computer Security 15 

15 Basic & Introduction 55 

Total  2,577 
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OSSSC Previous Year Questions (PYQ) 
Sl. No. Exam Name Year 
1 OSSSC RI 2015, 2021 

2 OSSSC PEO & JA 2023 

3 OSSSC CRE (ARI, AMIN, SFS, FG, EXCISE 

CONSTABLE) 

2022 

4 OSSSC JUNIOR CLERK 2015, 2017, 2018 

5 OSSSC LSI 2021 

6 OSSSC ICDS Supervisor 2016 

7 OSSSC Excise Constable 2014, 2019 

8 OSSSC VAW 2016 

9 OSSSC Jr. Stenographer 2015 

10 OSSSC Laboratory Technician 2021 

11 OSSSC MPHW 2023 

12 OSSSC Nursing 2020, 2023 

13 OSSSC SFS 2016 

14 OSSSC Pharmacist 2020 

15 OSSSC Radiographer 2020 
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OSSC Previous Year Questions (PYQ) 
Sl. No. Exam Name Year 
1 OSSC Assistant Sub-Inspector 2022 

2 OSSC Accountant 2022 

3 OSSC AMIN 2023 Pre & Mains 

4 OSSC BSSO 2022 (All 18 Shifts) 

5 OSSC CGL 2022 (All 18 Shifts) , 2023 

6 OSSC CHSL 2023 

7 OSSC CPGL 2023 

8 OSSC CTS 2023 

9 OSSC ESI 2023 

10 OSSC GPEO 2015 

11 OSSC Investigator 2022 (All 3 Shifts) 

12 OSSC WEO 2022 

13 OSSC JEA 2022 (All 16 Shifts) 

14 OSSC Junior Assistant 2022 (All 10 Shifts) 

15 OSSC Junior Clerk 2022 

16 OSSC SCEW 2022 (All 5 Shifts) 

17 OSSC SFS 2016 

18 OSSC Specialist 2023 

19 OSSC Stenographer 2023, 2024 

20 OSSC Supply Inspector 2017 

21 OSSC WEO 2022 (All 21 Shifts) 
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Odisha Police & Defence Previous Year Questions (PYQ) 
Sl. No. Exam Name Year 
1 Odisha Battalion / OSAP 2017 

2 Odisha Police Constable 2011, 2012, 2013, 2018, 

2023 

3 Odisha Fireman 2023 

4 Odisha Jail Warder 2022 (All 18 Shifts) 

5 OPRB SI Police 2016, 2017, 2019, 2022 

(All 11 Shifts), 2023 

6 OSSC Excise SI 2021 (All 9 Shifts), 2022 

7 OSSC Traffic Constable 2022 (All 6 Shifts) 

8 OSSC Traffic SI 2022 (All 4 Shifts) 
 

 

OPSC Previous Year Questions (PYQ) 
Sl. No. Exam Name Year 
1 OPSC ASO 2014, 2015, 2019, 2022 
2 OPSC OMAS 2019, 2023 
3 OPSC OAS Only Odisha GK Taken 

From All Previous Year 
Preliminary Exams 

4 OPSC Assistant Director Of  Fatory & Boiler 2023 Pre (Only Odisha GK 
Taken) 

5 OPSC Asst Director Handicraft 2023 Pre (Only Odisha GK 
Taken) 

 

Odisha High Court Previous Year Questions (PYQ) 
Sl. No. Exam Name Year 
1 OHC ASO 2021, 2023, 2023 (ST 

Special) 
 

Odisha Forest Development Corporation Previous Year Questions (PYQ) 
Sl. No. Exam Name Year 
1 OFDC Field Assistant 2021 
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Odisha Teaching Exams Previous Year Questions (PYQ) 
Sl. No. Exam Name Year 
1 CT 2018 (All 23 Shifts) 

2019 (All 24 Shifts) 
2020 (All 20 Shifts) 
2023 (All 11 Shifts) 

2 OTET 2022 
3 JT 2023 (All 14 Shifts) 
4 B.ED Entrance Exam  

ARTS & SCIENCE 2018 (All 11 Shifts) 
2019 (All 15 Shifts) 
2020 (All 13 Shifts) 
2021 (All 15 Shifts) 
2022 
2023 

6 OSSTET (ARTS, CBZ & PCM) 2018, 2019, 2021 (1st), 
2021 (2nd ), 2022, 2024 

7 RHT / High School Teacher   
 RHT  ARTS 2019 

2021 (All 3 Shifts) 
2022 (All 6 Shifts) 
2023 Pre (All 3 Shifts) 
2023 Mains 

 RHT  CBZ 2019 
2021 
2022 (All 3 Shifts) 
2023 Pre (All 3 Shifts) 
2023 Mains 

 RHT  PCM 2019 (All 2 Shifts) 
2021 (All 2 Shifts) 
2022 (All 4 Shifts) 
2023 Pre (All 3 Shifts) 
2023 Mains 

8 OAVS  
OAVS TGT ODIA 2018, 2019, 2021 
OAVS TGT ENGLISH 2019 
OAVS TGT SOCIAL STUDIES 2019, 2021, 2023 
OAVS TGT SCIENCE 2019, 2021 
OAVS TGT MATH 2019, 2023 
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Topic Name-  “ MS Word ” 
 

1- What is MS Word? 

ଏମଏସ ୱାଡର୍ କ'ଣ?  

 

[A] A big word 

[B] A dictionary 

[C] A word processor 

[D] A computer name 

[Odisha District Police Constable 2023] 

 

Ans-  C 

MS Word, short for Microsoft Word, is a popular word processing software 
developed and published by Microsoft Corporation. It is a part of the Microsoft 
Office suite, which includes other popular software applications like Excel, 
PowerPoint, and Outlook. 

ମାଇେ�ାସଫ� ୱାଡର୍ ପାଇଁ ସଂ�ି� ଏମଏସ ୱାଡର୍, ଏକ େଲାକ�ିୟ ଶ� ��ିୟାକରଣ ସଫ�େୱୟାର ଯାହା 
ମାଇେ�ାସଫ� କେପର୍ାେରସନ �ାରା ବକିଶତି ଏବଂ �କାଶତି । ଏହା ମାଇେ�ାସଫ� ଅଫିସ ସୁଇଟ୍ ର ଏକ 
ଅଂଶ, େଯଉଁଥିେର ଅନ୍ୟ େଲାକ�ିୟ ସଫ�େୱୟାର୍ ଆପି�େକସନ୍ େଯପରକି ିExcel, PowerPoint 
ଏବଂ Outlook ଅ�ଭର୍ୁ �। 
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2- Word processing, Spreadsheet, and photo-editing are examples 
of 

- ୱାଡର୍ େ�ାେସସଂି, େ��ଡସଟି୍ ଏବଂ ଫେଟା-ଏଡଟିଂି ____ର  ଉଦାହରଣ  

 

A. application software 

B. system software 

C. operating system software 

D. platform software 

[Odisha Jail Warder 2022]  

 

Ans-  A 

Word processing, spreadsheet, and photo-editing are examples of software 
applications 

Word processing software like Microsoft Word, Google Docs, or LibreOffice 
Writer is used for creating, editing, and formatting text-based documents such 
as letters, reports, and resumes. 

Spreadsheet software like Microsoft Excel, Google Sheets, or LibreOffice Calc 
is used for organizing, analyzing, and manipulating data in the form of rows 
and columns. 

Photo-editing software like Adobe Photoshop, GIMP, or PaintShop Pro is used 
for editing and manipulating digital images, including resizing, cropping, 
adjusting color, and adding effects. 
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ୱାଡର୍ େ�ାେସସଂି, େ��ଡସଟି୍ ଏବଂ ଫେଟା-ଏଡଟିଂି େହଉଛ ିସଫ�େୱର ଆପି�େକସନ୍ ର ଉଦାହରଣ 

 ମାଇେ�ାସଫ� ୱାଡର୍, ଗୁଗୁଲ ଡ�, କମି�ା ଲିେ�ଅଫିସ ରାଇଟର ଭଳ ି ୱାଡର୍ େ�ାେସସଂି ସଫ�େୱୟାର 
ଅ�ର, ରେିପାଟର୍ ଏବଂ ରଜିୟୁେମ ଭଳ ିେଟ�ଟ୍ ଆଧାରତି ଡକୁେମ� ତଆିର,ି ସ�ାଦନା ଏବଂ ଫମର୍ାଟଂି 
ପାଇଁ ବ୍ୟବହୃତ ହୁଏ । 

 ମାଇେ�ାସଫ� ଏେ�ଲ୍, ଗୁଗୁଲ୍ ସଟି୍ ସ କମି�ା ଲିେ�ଅଫିସ କାଲ୍ ସ ିଭଳ ିେ��ଡ୍ ସଟି୍ ସଫ�େୱୟାର୍ ଧାଡ଼ ି
ଏବଂ �� ଆକାରେର ଡାଟା ସଂଗଠତି, ବେି�ଷଣ ଏବଂ ପରଚିାଳନା ପାଇଁ ବ୍ୟବହୃତ ହୁଏ । 

 ଆେଡାବ ଫେଟାସପ୍, ଜଆିଇଏମପି, କମି�ା େପ�ସପ୍ େ�ା ପର ିଫେଟା-ଏଡଟିଂି ସଫ�େୱୟାର୍ ଡଜିଟିାଲ 
ଛବଗୁିଡ଼କିର ସ�ାଦନା ଏବଂ ପରଚିାଳନା ପାଇଁ ବ୍ୟବହୃତ ହୁଏ, େଯଉଁଥିେର ପୁନରୁ�ାର, ଫସଲ, ର� 
ଆଡଜ� କରବିା ଏବଂ �ଭାବ େଯାଡବିା ଅ�ଭର୍ୁ � । 

 

 

3- What will Shift + F7 do in a Word application? 

- ଏକ ୱାଡର୍ ଆପି�େକସନେର ସଫି� + F7 କ'ଣ କରବି?  

 

(A) Open the webpage 

(B) Open the hyperlink 

(C) Open the thesaurus  

(D) Open the image 

[OSSC BSSO 2022] 

 

Ans-  C 
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In a Word application, pressing Shift + F7 will bring up the Thesaurus pane. 
The Thesaurus is a tool in Microsoft Word that allows you to find synonyms 
(words with similar meanings) and antonyms (words with opposite meanings) 
for the selected word or phrase. 

ଏକ ୱାଡର୍ ଆପି�େକସନେର, ଶଫି� + F7 ଦବାଇେଲ ଥିେସାରସ୍ େପନ୍  ଆସବି  । ଥିେସାରସ େହଉଛ ି
ମାଇେ�ାସଫ� ୱାଡର୍ର ଏକ ଉପକରଣ ଯାହା ଆପଣ�ୁ ଚୟନତି ଶ� କମି�ା ବାକ୍ୟ ପାଇଁ ସମାଥର୍କ ଶ� 
(ସମାନ ଅଥର୍ ଥିବା ଶ�) ଏବଂ ବେିଲାମ (ବପିରୀତ ଅଥର୍ ଥିବା ଶ�) େଖାଜବିାକୁ ଅନୁମତ ିଦଏି । 

 

4- To create a newspaper-like layout in your Word document, you 
need to choose _______ option from the Layout tab. 

ଆପଣ� ୱାଡର୍ ଡକୁେମ� (Word document) େର ଖବରକାଗଜ ଭଳ ିେଲଆଉଟ (layout) 

��ୁତ କରିବା ପାଇ ଁ ଆପଣ େଲଆଉଟ ଟ୍ୟାବ (Layout tab) ରୁ _______ ଅପସନ ଚୟନ 

କରିବା ଆବଶ୍ୟକ । 

(A) Border 

 (B) Orientation  

 (C) Column  

 (D) Size 

[OSSC RHT High School Teacher 2023] 

 

Ans-  C 

The Columns option allows you to divide your document into multiple columns, 
just like a newspaper. You can choose the number of columns you want, the width 
of each column, and the spacing between columns. 

�� ବକି� ଆପଣ�ୁ ଏକ ଖବରକାଗଜ ପର ି ଆପଣ� ଡକୁେମ�କୁ ଏକାଧିକ ��େର ବଭି� କରବିାକୁ 
ଅନୁମତ ିଦଏି। ଆପଣ ଚାହୁଁଥିବା �� ସଂଖ୍ୟା, �େତ୍ୟକ ��ର �� ଏବଂ �� ମଧ୍ୟେର ବ୍ୟବଧାନ ଚୟନ 
କରପିାରେିବ। 
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5-  How to go to Page number 345 in a MS-WORD document 
containing 465 pages? 

- 465 ପ�ୃା ବଶି�ି ଏମଏସ-ୱାଡର୍ ଡକୁ୍ୟେମ�େର ପ�ୃା ନମ�ର 345କୁ କପିର ିଯିେବ?  

 

A) Press Ctrl + F, then enter 345 and press enter  

B) Press Ctrl+ R, then enter 345 and press enter 

C) Press Alt+G, then enter 345 and press enter  

D) Press Ctrl+G, then enter 345 and press enter 

[OSSSC Junior Clerk 2018] 

 

Ans- D 

• Press the "Ctrl" + "G" keys on your keyboard to open the "Go To" dialog 
box.  

• In the "Go To" dialog box, type in "345" in the "Page" field and click on the 
"Go To" button.  

• MS Word will jump to page 345 in your document. 
•  

• "େଗା ଟୁ" ଡାଏଲଗ ବ�  େଖାଲିବାକୁ ଆପଣ� କୀେବାଡର୍େର  "Ctrl" + "G" କୀ  ଦବା�ୁ।  

• "େଗା ଟୁ" ଡାଏଲଗ ବ�େର,  "ପ�ୃା" େ��େର "345" ଟାଇପ୍ କର�ୁ ଏବଂ "େଗା ଟୁ" ବଟନେର କି�କ୍ 

କର�ୁ  ।  

• MS ଶ� ଆପଣ� ଡକୁେମ�ର ପ�ୃା 345କୁ  େଡଇଁବ। 
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6- _________ option enables you to add common text at the top of 
all the pages in a Word document. 

- _____ ବକି� ଆପଣ�ୁ ଏକ ୱାଡର୍ ଡକୁ୍ୟେମ�େର ସମ� ପ�ୃାର ଶୀଷର୍େର ସାଧାରଣ େଟ�ଟ୍ 

େଯାଡବିାକୁ ସ�ମ କେର।  

 

(A) Footer 

(B) Header   

(C) Dropcap 

(D) Wordwrap 

[OSSC CGL Exam 2022] 

 

Ans- B 

 

A header is a section of a document that appears at the top of each page and 
contains information such as page numbers, document title, author name, 
company logo, and other relevant details. 

ଶୀଷର୍କ େହଉଛ ି ଏକ ଡକୁେମ�ର ଏକ ବଭିାଗ ଯାହା �େତ୍ୟକ ପ�ୃାର ଶୀଷର୍େର େଦଖାଯାଏ ଏବଂ 

ଏଥିେର ପ�ୃା ସଂଖ୍ୟା, ଡକୁେମ� ଶୀଷର୍କ, େଲଖକ ନାମ, କ�ାନୀ େଲାେଗା ଏବଂ ଅନ୍ୟାନ୍ୟ �ାସ�ିକ 

ବବିରଣୀ ପର ିସୂଚନା ରହଥିାଏ । 
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7-  Which key should be pressed to start a new paragraph in MS-
Word? 

- ଏମଏସ-ୱାଡର୍େର ଏକ ନୂତନ ପାରା�ାଫ୍ ଆର� କରବିା ପାଇଁ େକଉ ଁkey ଦବାଇବା ଉଚତି୍?  

 

A) Down Cursor Key 

B) Enter Key 

C) Shift + Enter 

D) Ctrl + Enter 

[OSSSC Junior Clerk 2018] 

 

Ans- B 

 

Pressing the "Enter" key creates a new line and moves the cursor to the 
beginning of the next line, effectively starting a new paragraph. This is the 
standard way to create paragraphs in most word processing software, including 
MS-Word. 

"ଏ�ର" କୀ ଦବାଇବା  �ାରା ଏକ ନୂତନ େରଖା ସ�ୃି ହୁଏ ଏବଂ କସର୍ରକୁ ପରବ�ର୍ୀ ଧାଡ଼ରି �ାର�କୁ 

�ାନା�ରତି କରାଯାଏ, �ଭାବଶାଳୀ ଭାବେର ଏକ ନୂତନ ପାରା�ାଫ୍ ଆର� ହୁଏ । ଏମଏସ-ୱାଡର୍ ସେମତ 

ଅଧିକାଂଶ ୱାଡର୍ େ�ାେସସଂି ସଫ�େୱୟାରେର ପାରା�ାଫ୍ ତଆିର ିକରବିାର ଏହା ଏକ ମାନକ ଉପାୟ ଅେଟ 

। 
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8- Which one of these does NOT belong to MS Office? 

- ଏମାନ� ମଧ୍ୟରୁ େକଉଁଟ ିଏମଏସ ଅଫିସର ନୁେହଁ?  

 

A) PowerPoint 

B) Excel 

C) Word 

D) Notepad 

[OSSC Junior Assistant 2022 Exam] 

 

Ans- D 

 

Notepad is a basic text editor program that comes pre-installed on Windows 
operating systems. It is a simple tool for creating and editing plain text files, but it 
does not have the advanced formatting and layout options of the other programs 
in MS Office, such as Word, Excel, and PowerPoint. 

େନାଟ�୍ୟାଡ୍ େହଉଛ ିଏକ େମୗଳକି େଟ�ଟ୍ ଏଡଟିର େ�ା�ାମ ଯାହା ୱେି�ାଜ୍ ଅପେରଟଂି ସ�ିମ୍ େର �ି-

ଇନ�ଲ୍ େହାଇଥାଏ। ଏହା ସାଦା େଟ�ଟ୍ ଫାଇଲ୍ ସ�ୃ ିଏବଂ ସ�ାଦନା ପାଇଁ ଏକ ସରଳ ଉପକରଣ, କ�ୁି 

ଏଥିେର MS ଅଫିସ୍ େର ଥିବା ଅନ୍ୟ େ�ା�ାମଗୁଡକିର ଉ�ତ ଫମର୍ାଟଂି ଏବଂ େଲଆଉଟ୍ ବକି� ନାହିଁ, 

େଯପରକି ିୱାଡର୍, ଏେ�ଲ ଏବଂ ପାୱାରପଏ�। 
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9- Which among the following is not a Video Conferencing Tool ? 

- ନମି�ଲିଖିତ ମଧ୍ୟରୁ େକଉଁଟ ିଭିଡଓି କନଫେରନି�ଂ ଟୁଲ୍ ନୁେହଁ ?  

 

A) Zoom Meetings 

B) MS Teams 

C) Google Meet 

D) MS Outlook 

[Odisha High School Teacher Exam 2022] 

 

Ans- D 

 

MS Outlook is an email and calendar management software developed by 
Microsoft. It is used for sending and receiving emails, managing contacts and 
calendars, and scheduling meetings. 

MS Outlook େହଉଛ ିମାଇେ�ାସଫ� �ାରା ବକିଶତି ଏକ ଇେମଲ୍ ଏବଂ କ୍ୟାେଲ�ର ପରଚିାଳନା 

ସଫ�େୱୟାର୍ । ଏହା ଇେମଲ୍ ପଠାଇବା ଏବଂ �ା� କରବିା, ସ�କର୍ ଏବଂ କ୍ୟାେଲ�ର ପରଚିାଳନା କରବିା 

ଏବଂ େବଠୖକର ସମୟ ନ�ିର୍ାରଣ ପାଇଁ ବ୍ୟବହୃତ ହୁଏ। 
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10- The quickest and easiest way in Word, to locate a particular 
word or phrase in a document is to use the command: 

- ଏକ ଡକୁେମ�େର ଏକ ନ�ିିର୍� ଶ� କମି�ା ବାକ୍ୟ ଚ�ିଟ କରବିା ପାଇଁ ଶ�ର ସବୁଠାରୁ ଦ�ତ ଏବଂ ସହଜ 

ଉପାୟ େହଉଛ ିକମା� ବ୍ୟବହାର କରବିା: 

(A) Replace 

(B) Find 

(C) Lookup 

(D) Search 

[OSSSC RI Exam 2021] 

 

Ans- B 

To use the "Find" command in Word, you can follow these steps:  

• Open the Word document that you want to search.  

• Press "Ctrl" + "F" on your keyboard to open the "Find and Replace" dialog box.  

• In the "Find what" field, type the word or phrase that you want to search for.  

• Click on the "Find Next" button to search for the first occurrence of the word or 
phrase. 

ୱାଡର୍େର "ସ�ାନ" କମା� ବ୍ୟବହାର କରବିାକୁ  , ଆପଣ ଏହ ିପଦେ�ପଗୁଡକି ଅନୁସରଣ କରପିାରେିବ:  

• ଆପଣ ସ�ାନ କରବିାକୁ ଚାହୁଁଥିବା ୱାଡର୍ ଡକୁ୍ୟେମ� େଖାଲ�ୁ।  

• "ସ�ାନ ଏବଂ ବଦଳା�ୁ" ଡାଏଲଗ ବ�  େଖାଲିବାକୁ ଆପଣ� କୀେବାଡର୍େର  "Ctrl" + "F" ଦବା�ୁ। 

• "କ'ଣ ସ�ାନ କର�ୁ" େ��େର, ଆପଣ ସ�ାନ କରବିାକୁ ଚାହୁଁଥିବା ଶ� କମି�ା ବାକ୍ୟ ଟାଇପ୍ କର�ୁ।  

•  ଶ� କମି�ା ବାକ୍ୟର �ଥମ ଘଟଣା ସ�ାନ କରବିାକୁ "ପରବ�ର୍ୀ ସ�ାନ" ବଟନେର କି�କ୍ କର�ୁ। 
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11- Which among the following print commands should be selected 
to print first 5 pages of document: 

- ଡକୁେମ�ର �ଥମ 5 ପ�ୃା ଛାପିବା ପାଇଁ ନମି�ଲିଖିତ �ି� କମା�ମଧ୍ୟରୁ େକଉଁଟ ିଚୟନ କରାଯିବା 

ଉଚତି୍:  

 

(A) Print All 

 (B) From_to_ 

(C) Page Setup 

(D) Page Control 

[OSSSC Combined Recruitment 2022] 

 

Ans- B 

 

The "Print All" command will print all pages of the document, while the "Page 
Setup" command is used to adjust the page settings such as margins, orientation, 
and size. The "Page Control" command is not a standard print command in 
Word. 

"�ି� ଅଲ୍" କମା� ଡକୁେମ�ର ସମ� ପ�ୃାଗୁଡକି ମୁ�ଣ କରବି, େଯେତେବେଳ କ ି"ପୃ�ା େସଟଅପ୍" 

କମା� ମାଜିର୍ନ୍, ଓରଏିେ�ସନ୍ ଏବଂ ଆକାର ପର ିପ�ୃା େସଟଂିସ୍ କୁ ଆଡଜ� କରବିାକୁ ବ୍ୟବହୃତ ହୁଏ। 

"ପୃ�ା ନୟି�ଣ" କମା� ୱାଡର୍େର ଏକ �ା�ାଡର୍ �ି� କମା� ନୁେହଁ। 
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12- In print preview, which one of the below actions cannot be 
performed? 

- �ି� �ିଭୁ୍ୟେର, ନମି�ଲିଖିତ �ିୟାଗୁଡକି ମଧ୍ୟରୁ େକଉଁଟ ିସ�ାଦତି େହାଇପାରବି ନାହିଁ? 

 

A) Changing Margins 

B) Change orientation of page 

C) Zoom in and zoom out 

D) Edit the document 

[OSSC Junior Clerk 2022] 

 

Ans- D 

 

In print preview, you can perform the following actions:  
A) Changing margins: You can adjust the margins of the document to 
change the layout of the content on the page.  
B) Change orientation of page: You can switch the orientation of the 
page between portrait and landscape mode to change the page layout.  
C) Zoom in and zoom out: You can zoom in or out to see a larger or 
smaller preview of the page. 
�ି� �ିଭୁ୍ୟେର, ଆପଣ ନମି�ଲିଖିତ �ିୟାଗୁଡକି ସ�ାଦନ କରପିାରେିବ:  

A) ମାଜିର୍ନ୍ ପରିବ�ର୍ନ କରିବା: ଆପଣ ପ�ୃାେର ବଷିୟବ�ୁର େଲଆଉଟ୍ ପରବି�ର୍ନ କରବିାକୁ 

ଡକୁେମ�ର ମାଜିର୍ନ୍ ଆଡଜ� କରପିାରେିବ।  

B) ପୃ�ାର ଓରିଏେ�ସନ୍ ପରିବ�ର୍ନ କର�ୁ: ଆପଣ ପ�ୃା େଲଆଉଟ୍ ପରବି�ର୍ନ କରବିାକୁ େପାେ�ଟ୍ 

ଏବଂ ଲ୍ୟା�େ�ପ େମାଡ୍ ମଧ୍ୟେର ପ�ୃାର ଓରଏିେ�ସନ୍ ପରବି�ର୍ନ କରପିାରେିବ।  

C) ଜୁମ୍ ଇନ୍ ଏବଂ ଜୁମ୍ ଆଉଟ୍: ଆପଣ ପ�ୃାର ଏକ ବଡ଼ କମି�ା େଛାଟ �ିଭୁ୍ୟ େଦଖିବା ପାଇଁ ଜୁମ୍ ଇନ୍ 

କମି�ା ବାହାରକୁ ଯାଇପାରେିବ। 
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13- How many ways you can save a document? 
- ଆପଣ ଏକ ଡକୁେମ�କୁ େକେତ ଉପାୟେର ସ�ୟ କରପିାରେିବ?  
 
A- 3 
B- 4 
C- 2 
D- 1 
[Odisha Police SI 2022 Exam] 
 
Ans- A 
 

• By clicking File on the top left corner and then click save as after that 
browse the location where exactly you want to save on your computer.  

• By just pressing Ctrl + S and then browse the location where you want to 
save.  

• By pressing F12 and then browse the location where you want to save. 

• ଉପର ବାମ େକାଣେର ଫାଇଲ୍ କି�କ୍ କର ିଏବଂ ତା'ପେର େସଭ୍ କି�କ୍ କର�ୁ ଏବଂ ଏହା ପେର େସଭ୍ କି�କ୍ 

କର�ୁ ଯାହା ପେର ଆପଣ ଆପଣ� କ�ୁ୍ୟଟରେର �କୃତେର ସ�ୟ କରବିାକୁ ଚାହୁଁଥିବା �ାନ�ାଉଜ୍ 

କର�ୁ।  

• େକବଳ Ctrl + S ଦବା �ାରା  ଏବଂ ତା'ପେର ଆପଣ ସ�ୟ କରବିାକୁ ଚାହୁଁଥିବା �ାନ�ାଉଜ୍ କର�ୁ।  

• F12  ଦବାଇ ଏବଂ ତା'ପେର ଆପଣ ସ�ୟ କରବିାକୁ ଚାହୁଁଥିବା �ାନ�ାଉଜ୍ କର�ୁ। 

 

14- In MS Word, which of the following do you use to change 
margins?  

- ଏମଏସ ୱାଡର୍େର, ଆପଣ ମାଜିର୍ନ ପରବି�ର୍ନ କରବିାକୁ ନମି�ଲିଖିତ ମଧ୍ୟରୁ େକଉଟଁ ିବ୍ୟବହାର କର�?ି  

 

A) formatting toolbar  

B) page setup dialog  box 

C) standard toolbar 
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D) paragraph dialog box 

[OSSSC Junior Clerk 2018] 

 

Ans- B 

 

In MS Word, you use the Page Setup dialog box to change margins. This dialog 
box provides options for setting margins, orientation, paper size, and other 
page layout settings. To access the Page Setup dialog box, you can either click 
on the Page Setup launcher in the Page Setup group on the Page Layout tab, or 
go to the File menu, select Page Setup, and then select the Margins tab. 

MS ୱାଡର୍େର, ଆପଣ ମାଜିର୍ନ୍ ପରବି�ର୍ନ କରବିାକୁ ପ�ୃା େସଟଅପ୍ ଡାଏଲଗ୍ ବ� ବ୍ୟବହାର କର�।ି 

ଏହ ିଡାଏଲଗ ବ� ମାଜିର୍ନ୍, ଓରଏିେ�ସନ୍, କାଗଜ ଆକାର ଏବଂ ଅନ୍ୟ ପ�ୃା େଲଆଉଟ୍ େସଟଂିସ୍ େସଟ୍ 

କରବିା ପାଇଁ ବକି� �ଦାନ କେର। ପ�ୃା େସଟଅପ୍ ଡାଏଲଗ୍ ବ�ଆକେସସ୍ କରବିାକୁ, ଆପଣ ପ�ୃା 

େଲଆଉଟ୍ ଟ୍ୟାବ୍ େର ପ�ୃା େସଟଅପ୍ ଗ�ପ୍ େର ଥିବା ପ�ୃା େସଟଅପ୍ ଲ�ର୍ ଉପେର କି�କ୍ କରପିାରେିବ  

, କମି�ା ଫାଇଲ୍ େମନୁ୍ୟକୁ ଯାଇ, ପୃ�ା େସଟଅପ୍ ଚୟନ କରପିାରେିବ, ଏବଂ ତା'ପେର ମାଜିର୍ନ୍ ଟ୍ୟାବ୍ 

ଚୟନ କରିପାରେିବ। 

 

15-  What programme is used in MS Word to check the spellings? 

 - ବନାନ ଯା� କରବିା ପାଇଁ ଏମଏସ ୱାଡର୍େର େକଉ ଁେ�ା�ାମ ବ୍ୟବହାର କରାଯାଏ?  

 

(A) Outlook Express  

(B) Spell-check 

(C) Speller 

(D) None of above 

[OSSSC Combined Recruitment 2022] 
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Ans- B 

 

• In MS Word, the program used to check spelling is called "Spelling and Grammar 
Checker".  

• To use the Spelling and Grammar Checker, you can either click on the "Spelling 
and Grammar" button in the Proofing group on the Review tab, or press "F7" on 
your keyboard. 

• ଏମଏସ ୱାଡର୍େର, ବନାନ ଯା� କରବିା ପାଇଁ ବ୍ୟବହୃତ େ�ା�ାମକୁ "େ�ଲିଂ ଏବଂ ବ୍ୟାକରଣ େଚକର" 

କୁହାଯାଏ ।  

• େ�ଲିଂ ଏବଂ ବ୍ୟାକରଣ େଚକର ବ୍ୟବହାର କରବିାକୁ, ଆପଣ  ସମୀ�ା ଟ୍ୟାବ୍ େର ଥିବା ପ�ଫିଂ ଗ�ପ୍ େର 

ଥିବା "େ�ଲିଂ ଏବଂ ବ୍ୟାକରଣ" ବଟନେର କି�କ୍ କରପିାରେିବ, କମି�ା ଆପଣ� କେିବାଡର୍େର "F7" ଦବା�ୁ। 

 

16- In MS Word, which shortcut key is used to print a document? 

- ଏମଏସ ୱାଡର୍େର, ଏକ ଡକୁେମ� ଛାପିବା ପାଇଁ େକଉଁ ସଟର୍କଟ୍ key ବ୍ୟବହାର କରାଯାଏ? 

 

(A) Shift + P 

(B) Alt + P 

(C) Tab + P 

(D) Ctrl + P 

[Odisha Police ASI 2022] 

 

Ans- D  
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• In MS Word, the shortcut key used to print a document is "Ctrl + P". This 
keyboard shortcut opens the Print dialog box, where you can choose the printer, 
set print options such as number of copies, page range, and paper size, and then 
print the document. 

• This shortcut is often quicker than going to the File menu and selecting Print, or 
using the Print button on the Quick Access Toolbar. 

• ଏମଏସ ୱାଡର୍େର, ଏକ ଡକୁେମ� ଛାପିବା ପାଇଁ ବ୍ୟବହୃତ ସଟର୍କଟ କୀ େହଉଛ ି "Ctrl + P"।  ଏହ ି
କୀେବାଡର୍ ସଟର୍କଟ୍ �ି� ଡାଇଲଗ୍ ବ� େଖାଲିଥାଏ, େଯଉଠଁାେର ଆପଣ �ି�ର୍ ଚୟନ କରପିାରେିବ, କପି 
ସଂଖ୍ୟା, ପ�ୃା ସୀମା ଏବଂ କାଗଜ ଆକାର ଭଳ ି�ି� ବକି� େସଟ୍ କରପିାରେିବ ଏବଂ ତା'ପେର ଡକୁେମ�କୁ 
�ି� କରପିାରେିବ। 

• ଫାଇଲ୍ େମନୁ୍ୟକୁ ଯାଇ �ି� ଚୟନ କରବିା କମି�ା �ିକ୍ ଆେ�ସ୍ ଟୁଲବାରେର �ି� ବଟନ୍ ବ୍ୟବହାର କରବିା 
ଅେପ�ା ଏହ ିସଟର୍କଟ୍ ଅଧିକାଂଶ ସମୟେର ଶୀ� େହାଇଥାଏ। 
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